Chapter 312

Tests for Two Total Variances in a 2×2 Cross-Over Design

Introduction

This procedure calculates power and sample size of tests of total variabilities (between + within) from a 2×2 cross-over design for the case when the ratio assumed by the null hypothesis is one. This routine deals with the case in which the statistical hypotheses are expressed in terms of the ratio of the total variances.

This design is used to compare two treatments which are administered to subjects in different orders. The design has two treatment sequences. The two sequences are

sequence 1: C T
sequence 2: T C

It is assumed that either there is no carry-over from one measurement to the next, or there is an ample washout period between measurements.

Technical Details

This procedure uses the formulation given in Chow, Shao, Wang, and Lokhnygina (2018), pages 224 - 227.

Suppose \(x_{ijk}\) is the response in the \(i\)th sequence \((i = 1, 2)\), \(j\)th subject \((j = 1, \ldots, N_i)\), and \(k\)th treatment \((k = T, C)\).

The mixed effect model analyzed in this procedure is

\[
x_{ijk} = \mu_k + \gamma_{ik} + S_{ij} + e_{ijk}
\]

where \(\mu_k\) is the \(k\)th treatment effect, \(\gamma_{ik}\) is the interaction between sequence \(i\) and treatment \(k\), \(S_{ij}\) and \(S_{ij}\) are random effects of the \(ij\)th subject, and \(e_{ijk}\) is the within-subject error term which is normally distributed with mean 0 and variance \(V_k = \sigma_{W_k}^2\).

Let \(N_s = N_1 + N_2 - 2\). The total variances \((\sigma_{T_k}^2 = \sigma_{\mu_k}^2 + \sigma_{W_k}^2, \ k = T, C)\) are estimated by

\[
\hat{\sigma}_{T_k}^2 = s_{T_k}^2 = \frac{1}{N_s} \sum_{i=1}^{N_1} \sum_{j=1}^{N_i} (\bar{x}_{ijk} - \bar{x}_{i,k})^2
\]
where

\[ \bar{x}_{l,k} = \frac{1}{N_l} \sum_{j=1}^{N_l} x_{ijk} \]

The sample between-subject covariance is calculated using

\[ s_B^{2TC} = \frac{1}{N_S} \sum_{i=1}^{2} \sum_{j=1}^{N_l} (x_{ijT} - \bar{x}_{i,T})(x_{ijC} - \bar{x}_{i,C}) \]

Using this value, the sample between-subject correlation is easily calculated.

**Testing Variance Inequality**

The following three sets of statistical hypotheses are used to test for total variance inequality

\[ H_0: \frac{\sigma^2_T}{\sigma^2_C} \geq 1 \text{ versus } H_1: \frac{\sigma^2_T}{\sigma^2_C} < 1, \]

\[ H_0: \frac{\sigma^2_T}{\sigma^2_C} \leq 1 \text{ versus } H_1: \frac{\sigma^2_T}{\sigma^2_C} > 1, \]

\[ H_0: \frac{\sigma^2_T}{\sigma^2_C} = 1 \text{ versus } H_1: \frac{\sigma^2_T}{\sigma^2_C} \neq 1, \]

Let \( \eta = \sigma^2_T - \sigma^2_C \) be the parameter of interest. The test statistic is \( \hat{\eta} = \hat{\sigma}^2_T - \hat{\sigma}^2_C \).

**Two-Sided Test**

For the two-sided test, compute two limits, \( \hat{\eta}_L \) and \( \hat{\eta}_U \), using

\[ \hat{\eta}_L = \hat{\eta} - \sqrt{\Delta_L} \]

\[ \hat{\eta}_U = \hat{\eta} + \sqrt{\Delta_U} \]

Reject the null hypothesis if \( \hat{\eta}_L > 0 \) or \( \hat{\eta}_U < 0 \).

The \( \Delta s \) are given by

\[ \Delta_L = h \left( 1 - \frac{\alpha}{2}, N_S \right) \chi^2_1 + h \left( \frac{\alpha}{2}, N_S \right) \chi^2_2 \]

\[ \Delta_U = h \left( \frac{\alpha}{2}, N_S \right) \chi^2_1 + h \left( 1 - \frac{\alpha}{2}, N_S \right) \chi^2_2 \]

where

\[ h(A, B) = \left( 1 - \frac{B}{\chi^2_{A,B}} \right)^2 \]

\[ \chi^2_i = \left( \frac{s^2_T - s^2_C}{2} \pm \frac{(s_T^2 + s_C^2 - s_{BTC}^2)^2 - 4s^4_{BTC}}{2} \right) \text{ for } i = 1, 2 \]

and \( \chi^2_{A,B} \) is the upper quantile of the chi-square distribution with \( B \) degrees of freedom.
**One-Sided Test**

For the lower, one-sided test, compute the limit, $\hat{\eta}_U$, using

$$\hat{\eta}_U = \hat{\eta} + \sqrt{\Delta_U}$$

Reject the null hypothesis if $\hat{\eta}_U < 0$.

The $\Delta_U$ is given by

$$\Delta_U = h(\alpha, N_s - 1)\lambda_1^2 + h(1 - \alpha, N_s - 1)\lambda_2^2$$

---

**Power**

**Two-Sided Test**

The power of the two-sided test is given by

$$\text{Power} = 1 - \Phi\left(z_{1-\frac{\alpha}{2}} - \frac{(R_1 - 1)\sigma^2_{\text{FC}}}{\sqrt{\sigma^*^2/N_s}}\right) + \Phi\left(z_{\alpha/2} - \frac{(R_1 - 1)\sigma^2_{\text{FC}}}{\sqrt{\sigma^*^2/N_s}}\right)$$

where

$$R_1 = \frac{\sigma^2_{\text{TR}}}{\sigma^2_{\text{FC}}}$$

$$\sigma^2_{\text{TR}} = R_1\sigma^2_{\text{FC}}$$

$$\sigma^*^2 = 2[\sigma^4_{\text{TR}} + \sigma^4_{\text{FC}} - 2\sigma^2_{\text{TR}}\sigma^2_{\text{FC}}\rho^2]$$

where $R1$ is the value of the variance ratio stated by the alternative hypothesis and $\Phi(x)$ is the standard normal CDF.

A simple binary search algorithm can be applied to the power function to obtain an estimate of the necessary sample size.

**One-Sided Test**

The power of the lower, one-sided test, $H_0: \frac{\sigma^2_{\text{TR}}}{\sigma^2_{\text{FC}}} \geq 1$ versus $H_1: \frac{\sigma^2_{\text{TR}}}{\sigma^2_{\text{FC}}} < 1$, is given by

$$\text{Power} = \Phi\left(z_\alpha - \frac{(R_1 - 1)\sigma^2_{\text{FC}}}{\sqrt{\sigma^*^2/N_s}}\right)$$

The power of the upper, one-sided test, $H_0: \frac{\sigma^2_{\text{TR}}}{\sigma^2_{\text{FC}}} \leq 1$ versus $H_1: \frac{\sigma^2_{\text{TR}}}{\sigma^2_{\text{FC}}} > 1$, is given by

$$\text{Power} = 1 - \Phi\left(z_{1-\alpha} - \frac{(R_1 - 1)\sigma^2_{\text{FC}}}{\sqrt{\sigma^*^2/N_s}}\right)$$
Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and power.

Solve For

This option specifies the parameter to be solved for from the other parameters. Under most situations, you will select either Power or Sample Size.

Test Direction

Alternative Hypothesis

Specify whether the alternative hypothesis of the test is one-sided or two-sided.

Note that this parameter impacts the value of alpha. The value of alpha is used directly for one-sided tests. For two-sided tests, alpha is replaced by alpha/2.

Two-Sided Hypothesis Test

H0: \( \sigma^2_{TT}/\sigma^2_{TC} = 1 \) vs. H1: \( \sigma^2_{TT}/\sigma^2_{TC} \neq 1 \)

One-Sided Hypothesis Tests

Lower: H0: \( \sigma^2_{TT}/\sigma^2_{TC} \geq 1 \) vs. H1: \( \sigma^2_{TT}/\sigma^2_{TC} < 1 \)

Upper: H0: \( \sigma^2_{TT}/\sigma^2_{TC} \leq 1 \) vs. H1: \( \sigma^2_{TT}/\sigma^2_{TC} > 1 \)

Power and Alpha

Power

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

Alpha

This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis when it is true.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
Sample Size (When Solving for Sample Size)

Sequence Allocation
Select the option that describes the constraints on N1 or N2 or both.

The options are

- **Equal (N1 = N2)**
  This selection is used when you wish to have equal sample sizes in each sequence. Since you are solving for both sample sizes at once, no additional sample size parameters need to be entered.

- **Enter N2, solve for N1**
  Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

- **Enter R = N2/N1, solve for N1 and N2**
  For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2, with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
  \[ N2 = R \times N1. \]

- **Enter percentage in Sequence 1, solve for N1 and N2**
  For this choice, you set a value for the percentage of the total sample size that is in Sequence 1, and then PASS determines the needed N1 and N2 with this percentage to obtain the desired power.

**N2 (Sample Size, Sequence 2)**
*This option is displayed if Sequence Allocation = “Enter N2, solve for N1”*

N2 is the number of items or individuals sampled from the Sequence 2 population.

N2 must be \( \geq 2 \). You can enter a single value or a series of values.

**R (Sequence Sample Size Ratio)**
*This option is displayed only if Sequence Allocation = “Enter R = N2/N1, solve for N1 and N2.”*

R is the ratio of N2 to N1. That is,

\[ R = \frac{N2}{N1}. \]

Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this ratio are considered.

N2 is related to N1 by the formula:

\[ N2 = \lceil R \times N1 \rceil, \]

where the value \( \lceil Y \rceil \) is the next integer \( \geq Y \).

For example, setting \( R = 2.0 \) results in a Sequence 2 sample size that is double the sample size in Sequence 1 (e.g., \( N1 = 10 \) and \( N2 = 20 \), or \( N1 = 50 \) and \( N2 = 100 \)).

R must be greater than 0. If \( R < 1 \), then N2 will be less than N1; if \( R > 1 \), then N2 will be greater than N1. You can enter a single or a series of values.
Percent in Sequence 1

This option is displayed only if Sequence Allocation = “Enter percentage in Sequence 1, solve for N1 and N2.”

Use this value to fix the percentage of the total sample size allocated to Sequence 1 while solving for N1 and N2. Only sample size combinations with this Sequence 1 percentage are considered. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Sequence 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)

Sequence Allocation

Select the option that describes how individuals in the study will be allocated to Sequence 1 and to Sequence 2.

The options are

- **Equal (N1 = N2)**
  
  This selection is used when you wish to have equal sample sizes in each sequence. A single per sequence sample size will be entered.

- **Enter N1 and N2 individually**
  
  This choice permits you to enter different values for N1 and N2.

- **Enter N1 and R, where N2 = R * N1**
  
  Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

- **Enter total sample size and percentage in Sequence 1**
  
  Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N, and then N2 as N - N1.

Sample Size Per Sequence

This option is displayed only if Sequence Allocation = “Equal (N1 = N2).”

The Sample Size Per Sequence is the number of items or individuals sampled. Since the sample sizes are the same in each sequence, this value is the value for N1, and also the value for N2.

The Sample Size Per Sequence must be ≥ 2. You can enter a single value or a series of values.

**N1 (Sample Size, Sequence 1)**

This option is displayed if Sequence Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 = R * N1.”

N1 is the number of items or individuals sampled from the Sequence 1 population. N1 must be ≥ 2. You can enter a single value or a series of values.

**N2 (Sample Size, Sequence 2)**

This option is displayed only if Sequence Allocation = “Enter N1 and N2 individually.”

N2 is the number of items or individuals sampled from the Sequence 2 population. N2 must be ≥ 2. You can enter a single value or a series of values.
R (Sequence Sample Size Ratio)

This option is displayed only if Sequence Allocation = “Enter N1 and R, where N2 = R * N1.”

R is the ratio of N2 to N1. That is,

\[ R = \frac{N2}{N1} \]

Use this value to obtain N2 as a multiple (or proportion) of N1.

N2 is calculated from N1 using the formula:

\[ N2 = \lceil R \times N1 \rceil, \]

where the value \( \lceil Y \rceil \) is the next integer ≥ Y.

For example, setting R = 2.0 results in a Sequence 2 sample size that is double the sample size in Sequence 1.

R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can enter a single value or a series of values.

Total Sample Size (N)

This option is displayed only if Sequence Allocation = “Enter total sample size and percentage in Sequence 1.”

This is the total sample size, or the sum of the two sequence sample sizes. This value, along with the percentage of the total sample size in Sequence 1, implicitly defines N1 and N2.

The total sample size must be greater than one, but practically, must be greater than 3, since each sequence sample size needs to be at least 4.

You can enter a single value or a series of values.

Percent in Sequence 1

This option is displayed only if Sequence Allocation = “Enter total sample size and percentage in Sequence 1.”

This value fixes the percentage of the total sample size allocated to Sequence 1. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Sequence 1 must be greater than 0 and less than 100. You can enter a single value or a series of values.

Effect Size

R1 (Actual Variance Ratio)

Enter one or more values for total variance ratio assumed by the alternative hypothesis. This is the value of \( \sigma^2 \text{tt} / \sigma^2 \text{tc} \) at which the power is calculated.

The range of possible values is R1 > 0. R1 ≠ 1.

\( \sigma^2 \text{tc} \) (Control Variance)

Enter one or more values for variance of the average subject control measurements. This value will have to be determined from a previous study or a pilot study.

The range of possible values is \( \sigma^2 \text{tc} > \sigma^2 \text{wc} \).

\( \sigma^2 \text{wt} \) (Treatment, Within-Subject Variance)

Enter one or more values for within-subject variance of the treatment measurements. This value will have to be determined from a previous study or a pilot study.

The range of possible values is \( \sigma^2 \text{wt} > 0 \).
σ²\(_{wc}\) (Control, Within-Subject Variance)

Enter one or more values for within-subject variance of the control measurements. This value will have to be determined from a previous study or a pilot study.

The range of possible values is σ²\(_{wc}\) > 0.

ρ (Treatment, Control Correlation)

Enter one or more values for the between-subject (intersubject) correlation. This is the correlation between the two observations, treatment and control, made on each subject.

This value will have to be determined from a previous study or a pilot study.

The range of possible values is \(-1 \leq \rho \leq 1\).
Example 1 – Finding Sample Size

A company has developed a generic drug for treating rheumatism and wants to compare it to the standard drug in terms of the total variability. A 2 x 2 cross-over design will be used to test the inequality using a two-sided test.

Company researchers set the significance level to 0.05, the power to 0.90, and the actual variance ratio values between 0.5 and 1.3. They also set $\sigma^2_{tc} = 0.8$, $\sigma^2_{wt} = 0.2$, $\sigma^2_{wc} = 0.3$, and $\rho = 0.7$. They want to investigate the range of required sample size values assuming that the two sequence sample sizes are equal.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for Two Total Variances in a 2x2 Cross-Over Design procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided (H1: $\sigma^2_{tt}/\sigma^2_{tc} \neq 1$)</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Sequence Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>R1 (Actual Variance Ratio)</td>
<td>0.5 0.7 0.9 1.1 1.3</td>
</tr>
<tr>
<td>$\sigma^2_{tc}$ (Control Variance)</td>
<td>0.8</td>
</tr>
<tr>
<td>$\sigma^2_{wt}$ (Treatment Variance)</td>
<td>0.2</td>
</tr>
<tr>
<td>$\sigma^2_{wc}$ (Control Variance)</td>
<td>0.3</td>
</tr>
<tr>
<td>$\rho$ (Treatment, Control Correlation)</td>
<td>0.7</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

References


Report Definitions
Actual Power is the actual power achieved. Because N1 and N2 are discrete, this value is usually slightly larger than the target power.
N1 is the number of subjects in sequence 1.
N2 is the number of subjects in sequence 2.
N is the total number of subjects. N = N1 + N2.
R1 is the value of the total variance ratio at which the power is calculated.
σ².tc is the total variance of measurements in the control group. Note that σ².tc = σ².wc + σ².wt.
σ².wt is the within-subject variance of measurements in the treatment group.
σ².wc is the within-subject variance of measurements in the control group.
p is the between-subject correlation of the treatment versus control measurements.
Alpha is the probability of rejecting a true null hypothesis, H0.

Summary Statements ─────────────────────────────────────────────────────────
A study is being conducted to compare the total variance of a treatment group to a control group using a two-sided hypothesis test of data from a 2 × 2 cross-over design. Sequence sample sizes of 48 and 48 achieve 91% power to reject the null hypothesis at a significance level of 0.050. The variance ratio assumed by the null hypothesis is 1.0. The variance ratio at which the power is calculated is 0.500. The actual total variance of the control group is assumed to be 0.800. The actual within-subject variance of the treatment group is assumed to be 0.200. The actual within-subject variance of the control group is assumed to be 0.300. The between-subject correlation between the treatment and control measurements per subject is assumed to be 0.700.

This report gives the sample sizes for the indicated scenarios.

Plot Section

This plot shows the relationship between sample size and R1.
Example 2 – Validation using another PASS Procedure

We previously validated the Non-Unity Null Tests for Two Total Variances in a 2×2 Cross-Over Design procedure which can be used to run this example. Hence, we will run an example through that procedure and use it to validate this procedure.

In the Non-Unity Null Tests for Two Total Variances in a 2×2 Cross-Over Design procedure, set the variance ratio under the null hypothesis to 1.0, the significance level to 0.05, the power to 0.80, and the actual variance ratio values to 1.2. They also set $\sigma^2_{tc} = 0.8$, $\sigma^2_{wt} = 0.2$, $\sigma^2_{wc} = 0.3$, and $\rho = 0.7$. The sample size is computed as 366 per sequence for the two-sided case.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for Two Total Variances in a 2×2 Cross-Over Design procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td>Solve For</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided (H1: $\sigma^2_{tt}/\sigma^2_{tc} \neq 1$)</td>
</tr>
<tr>
<td>Power</td>
<td>0.80</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Sequence Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>R1 (Actual Variance Ratio)</td>
<td>1.2</td>
</tr>
<tr>
<td>$\sigma^2_{tc}$ (Control Variance)</td>
<td>0.8</td>
</tr>
<tr>
<td>$\sigma^2_{wt}$ (Treatment Variance)</td>
<td>0.2</td>
</tr>
<tr>
<td>$\sigma^2_{wc}$ (Control Variance)</td>
<td>0.3</td>
</tr>
<tr>
<td>$\rho$ (Treatment, Control Correlation)</td>
<td>0.7</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Numeric Results</th>
<th>H0: $\sigma^2_{tt}/\sigma^2_{tc} = 1$ vs. H1: $\sigma^2_{tt}/\sigma^2_{tc} \neq 1$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual Power</td>
<td>0.8004</td>
</tr>
<tr>
<td>Seq 1 Sample Size</td>
<td>N1 = 366</td>
</tr>
<tr>
<td>Seq 2 Sample Size</td>
<td>N2 = 366</td>
</tr>
<tr>
<td>Sample Size</td>
<td>N = 732</td>
</tr>
<tr>
<td>Actual Ratio</td>
<td>R1 = 1.200</td>
</tr>
<tr>
<td>Var Cntl</td>
<td>$\sigma^2_{tc}$ = 0.800</td>
</tr>
<tr>
<td>Var Trt</td>
<td>$\sigma^2_{wt}$ = 0.200</td>
</tr>
<tr>
<td>Var Cntl</td>
<td>$\sigma^2_{wc}$ = 0.300</td>
</tr>
<tr>
<td>Corr Trt vs Cntl</td>
<td>$\rho = 0.700$</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.050</td>
</tr>
</tbody>
</table>

The sample size of 366 per sequence matches the expected result.